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1 System Requirements 
VP7configure™ will run on Windows 2000 or Windows XP.  A COMM port is required 
to communicate with a VP7™ box. 

2 Installation 
2.1 Installing VP7configure™ for the First Time 
If the PC has never had the VP7configure™ application installed, follow these steps to 
install the application. 

STEP 1: Insert the distribution disk into the CD-ROM drive of the PC or a CD-ROM 
drive networked to the PC and view the contents of the CD in the Windows 
Explorer window. 

STEP 2: Double click on “VP7CONFIGURE SETUP.EXE” file. 

STEP 3: Follow the on-screen instructions to install the VP7configure™ 
application. 

2.2 Removing VP7configure™ 
STEP 1: Uninstall the existing VP7configure™ application by double clicking the 

“Add/Remove Programs” applet in the Control Panel. 

STEP 2: Select “VP7configure” from the list of programs and click the 
Add/Remove button. 

STEP 3: Follow the on-screen instructions to uninstall the VP7configure™ 
application. 

2.3 Updating VP7configure™ 
STEP 1:  Remove the existing VP7configure™ application following the steps in 

Section 2.2. 

STEP 2:  Install the VP7configure™ application following the steps in Section 2.1. 

 
Westar Display Technologies, Inc. 
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3 Creating a Connection 
To create a new connection to a VP7™ box, select File->New Connection from the 
menu bar, or press Ctrl + N on the keyboard.  The VP7configure™ Wizard window will 
appear. 

 
Figure 1 VP7configure™ Wizard 

Westar Display Technologies, Inc. 
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4 Using the VP7configure™ Wizard 
The VP7configure™ Wizard performs the steps necessary to configure a VP7™ box.   Its 
graphical user interface outlines the logical flow for setting up a VP7™.  It can be used 
while a VP7™ is connected and changes can be applied immediately, or a file can be 
created, saved, and applied to a VP7™ at a later time. 

4.1 Connecting to a VP7™ 
To connect to a VP7™, connect the RS-232 connector of the VP7™ to the RS-232 
communications port on the computer.  Select the COM port number from the COM: 
drop-down menu.  Then click the red To Connect button.  

 
Figure 2 Connect 

If a VP7™ is detected, a window will appear asking “Do you want to load settings from 
the VP7 into the wizard?”  Select Yes if you wish to read the settings from the VP7™, 
and load them into the VP7configure™ Wizard.  Select No to retain the settings that are 
already in the VP7configure™ Wizard. 

 
Figure 3 Load Settings 

If the VP7 was in AUTO mode, it will be set to fixed mode while editing, and can then be 
set back to AUTO mode upon disconnecting.  A message will appear indicating this.   

After connecting, the button labeled “To Connect” will change to green and be labeled 
“To Disconnect.”  The “Table” (see section 4.1.1), “Firmware Version,” and “FGPA 
Revision” will be shown. 

Westar Display Technologies, Inc. 
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To disconnect from a VP7™, click the green To Disconnect button. 

 
Figure 4 Disconnect 

4.1.1 Selecting a Table 
The VP7™ allows for 8 different “tables,” or configuration sets.  Once a VP7™ is 
connected, the “Table” drop down list will be enabled, and the table number will be 
automatically selected.  To change the table, click the drop down list, and select from 0 
through 7.  After changing the table, a window will appear asking "Do you want to load 
settings from the VP7 table into the wizard?"  Select Yes if you wish to read the settings 
from the VP7™ table, and load them into the VP7configure™ Wizard.  Select No to 
retain the settings that are already in the VP7configure™ Wizard. 

4.1.2 AUTO Table Selection 
The VP7™ can be set up to automatically load the table which matches the input video.  
A table must be created for every possible input video to use auto-mode.  Using AUTO 
mode is not recommended when the input video is constant.  AUTO mode is only 
supported in VP7™ firmware version 3.0 and later. 

The AUTO mode currently only matches video based on the Analog RGB 
synchronization type (see section 4.3.2.1). 

To enable AUTO mode, select AUTO on Disconnect.  The option will have been already 
selected if the VP7™ was already in AUTO mode when connected.  The VP7™ will be 
set to AUTO upon disconnecting.  To disable AUTO mode, deselect AUTO on 
Disconnect, and click To Disconnect. 

Westar Display Technologies, Inc. 
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4.2 Running the Wizard  
The wizard performs the following steps: 

STEP 1: Configure input capture parameters. 

STEP 2: Define the characteristics of the output video. 

STEP 3: Select the area of interest of the input video.  Scale and position the area 
of interest onto the output video. 

STEP 4: Define the power sequences for the panel and backlight.  Select the action 
to take when valid input video is lost. 

STEP 5: Select methods for controlling Contrast and Brightness. 

STEP 6: Adjust the color capture from the input video.  Adjust the input capture 
boundary and ADC clock phase. 

 
Figure 5 Wizard 

Westar Display Technologies, Inc. 

5 



VP7configure™ User’s Manual                                                                                                   Revision 1.6 

 

 

4.2.1 Entering the Wizard 
To begin using the wizard, click Start…  If you have previously engaged the wizard, but 
closed out of the process, click Resume… to return to where you left off. To move 
directly to an individual step within the process you may click the corresponding button 
on the main window.  While inside a step, the corresponding button will be highlighted in 
a yellow square.  Starting at the beginning of the wizard is recommended when 
configuring a VP7™. 

4.2.2 Moving Between Steps 
To move to the next step in the wizard process, click Next> in the lower right hand 
corner of the window.  To move to the previous step click <Previous.  On the last step of 
the wizard, click Finish to leave the wizard.  To leave the wizard, and discard the 
changes for the current step, close the window by clicking the X in the upper right hand 
corner of the window. 

 
Figure 6 Next, Previous 

The wizard validates each step after it is performed.  When you click “Next>” or 
“<Previous,” the parameters you just entered will be checked.  If they are valid, the 
wizard will move on, and the button corresponding to the step will turn green.  If a 
problem is found, a message will be displayed describing the problem.  It will ask, 
“Continue anyway?”  If you select Yes, the wizard will move on, but the button will 
remain red.  If you select No, the wizard will remain at the current step. 

 
Figure 7 Problem Found 

Westar Display Technologies, Inc. 
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4.3 Input Setup 
The parameters for capturing the input video are defined under “Input Setup.”  This is the 
first step in the configuration process.  To go directly to this step, click the button under 
“Step #1:  Input Setup.”  

 
Figure 8 Input Setup 

Westar Display Technologies, Inc. 
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4.3.1 Input Timing Parameters 
The input timing parameters are set to match the characteristics of the input video so the 
video data can be correctly captured.  If the input parameters are changed at any time, the 
input adjustments will be reset to zero. 

4.3.1.1 VESA Standard 
There are several predefined timing specifications that can be automatically applied to the 
timing parameters.  To use a predefined standard, click the drop-down list and select the 
one you wish to use.  The fields in the “Input Timing Parameters” frame will be 
automatically filled in. 

If the parameters in the fields match one of the VESA standards in the list, that standard 
will automatically be selected in the drop-down list.  If not, Custom will be selected in 
the list. 

4.3.1.2 Scan Type 
Select Progressive if each line of input video is sent one line after the other.  Select 
Interlaced if lines are sent in two interlaced fields, one containing even numbered lines 
and the other containing odd numbered lines.  Select Interlaced Static if the input video 
is interlaced static mesh.  Interlaced Static is supported in VP7™ firmware version 3.0 
and later. 

If the input video is interlaced, the back porch values for the odd and even lines can be 
different.  When Interlaced is selected, an additional field for the even back porch value 
is added to the “Vertical” parameters. 

 
Figure 9 Progressive Scan 

 
Figure 10 Interlaced

Westar Display Technologies, Inc. 
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4.3.1.3 Vertical 

 
Figure 11 Vertical Timing Diagram 

Total 
Vertical Total defines the total number of lines of input video, including blanking. 

Active 
Vertical Active defines the number of active or visible lines of input video. 

 Pulse Width 
Vertical Pulse Width defines the width of the vertical sync pulse in lines. 

Back Porch 
Vertical Back Porch defines the number of lines between the end of the vertical sync 
pulse and the beginning of active video.  If Progressive is selected as the scan type, only 
“Back Porch” is used.  If Interlaced is selected, “Back Porch Odd” defines the back 
porch for the odd fields, and “Back Porch Even” defines the back porch for the even 
fields. 

Front Porch 
Vertical Front Porch defines the number of lines between the end of active video and the 
beginning of the vertical sync pulse.  It is calculated automatically when a vertical timing 
parameter changes, and cannot be set.  If Progressive is selected as the scan type, only 
“Front Porch” is shown.  If Interlaced is selected, “Front Porch Odd” shows the front 
porch for the odd fields, and “Front Porch Even” shows the front porch for the even 
fields. 

Polarity 
Vertical Polarity defines the polarity of the vertical sync pulse.  Select Positive if the 
pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.3.1.4 Horizontal 

 
Figure 12 Horizontal Timing Diagram 

Total 
Horizontal Total defines the total number of pixels in one line of input video, including 
blanking. 

Active 
Horizontal Active defines the number of active or visible pixels of one line of input 
video. 

 Pulse Width 
Horizontal Pulse Width defines the width of the horizontal sync pulse in pixels. 

Back Porch 
Horizontal Back Porch defines the number of pixels between the end of the horizontal 
sync pulse and the beginning of active video. 

Front Porch 
Horizontal Front Porch defines the number of lines between the end of active video and 
the beginning of the horizontal sync pulse.  It is calculated automatically when a 
horizontal timing parameter changes, and cannot be set.   

Polarity 
Horizontal Polarity defines the polarity of the horizontal sync pulse.  Select Positive if 
the pulse is active high, and Negative if the pulse is active low. 

Line Time or Pixel Clock 
The capture rate can either be defined by line time or the pixel clock rate.  Select line 
time by clicking the Line Time option or pixel clock by selecting the Pixel Clock option.  
“Line Time” defines the time that it takes to scan one line of video.  Its units are 
microseconds (µsec).  “Pixel Clock” defines the rate that pixels are scanned.  Its units are 
megahertz (MHz). 

Westar Display Technologies, Inc. 
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4.3.2 Input Electrical 
The input electrical parameters define the format of the input video.  There are three 
choices for video formats selectable by radio buttons:  Analog RGB, TMDS, and Video.  
When a format is selected, the fields to the right of the choices will change to match the 
selected format.  (*NOTE* “Video” is not supported yet, and its button is disabled.) 

4.3.2.1 Analog RGB 
Select Analog RGB if the input video format is analog RGB.  Complete the fields to the 
right to configure the analog to digital converter.  

 
Figure 13 Analog RGB 

Synchronization 
Select Digital Separate Sync if the horizontal and vertical synchronization signals are 
separate.  Select Digital Composite Sync if the horizontal and vertical synchronization 
signals are combined into one signal.  Select Analog Composite Sync (sync on green) if 
the horizontal and vertical synchronization signals are combined on the green video 
signal. 

Offset Bias 
The offset biases are added to the calibration values that eliminate the DC offset from the 
analog video signals.  Each color component (R, G, and B) has an offset bias. 

Gain Bias 
The gain biases are added to the calibration values that aligns the full analog RGB range 
of the analog video signals.  Each color component (R, G, and B) has a gain bias. 

Clamp Placement 
“Clamp Placement” defines the starting position after a horizontal sync pulse when the 
input analog signal is clamped for DC restoration.  It is programmed in increments of 
eight input clock edges.  In most cases, the clamp placement can be set to “1.” 

Clamp Width 
“Clamp Width” defines the interval that the input analog signal is clamped for DC 
restoration.  It is programmed in increments of eight input clock edges.  In most cases, 
the clamp width can be set to “4.” 

Westar Display Technologies, Inc. 
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4.3.2.2 TMDS 
Select TMDS if the input video format is TMDS. 

 
Figure 14 TMDS 

Clock Edge 
Select Falling if pixel data is latched on the falling edge of the input clock.  Select Rising 
if pixel data is latched on the rising edge of the input clock. 

Use Data Enable 
Select the option Use Data Enable to use the data enable signal to qualify active data.  
De-select the option to identify active data arbitrarily within the line. 

Data Enable Polarity 
Select Positive if active data is present when the data enable signal is high.  Select 
Negative if active data is present when the data enable signal is low. 

Westar Display Technologies, Inc. 
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4.4 Output Setup 
The parameters for the output video are configured under “Output Setup.”  This is the 
second step in the configuration process.  To go directly to this step, click the button 
under “Step #2:  Output Setup.”  

 
Figure 15 Output Setup 

4.4.1 Output Sync 

4.4.1.1 Clock 
Select Clock to use an internally generated output clock to generate the output video. 

4.4.1.2 Frame Ratio 
Select Frame Ratio to synchronize the output video to the input video at a certain ratio 
of frames.  For every number of frames of input video, there can be a certain number of 
frames output.  When using “Frame Ratio,” the pixel clock of the output video is adjusted 
to satisfy the ratio.  Enter the number of input frames into In Frames, and the number of 
output frames into Out Frames. 

Westar Display Technologies, Inc. 
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4.4.1.3 Frame Sync 
Select Frame Sync to synchronize the refresh rate of the output video to that of the input 
video.  One output frame is generated for every input frame and a constant phase 
relationship exists between the output and input frames such that no video data is lost.  
There will be limits to this feature.  At this time, we cannot guarantee the output timing 
parameters. 

4.4.2 Output Timing Parameters 
The output timing parameters define the timing characteristics of the output video. 

4.4.2.1 VESA Standard 
There are several predefined timing specifications that can be automatically applied to the 
timing parameters.  To use a predefined standard, click the drop-down list and select the 
one you wish to use.  The fields in the “Output Timing Parameters” frame will be filled in 
automatically. 

If the parameters in the fields match one of the VESA standards in the list, that standard 
will automatically be selected in the drop-down list.  If not, Custom will be selected in 
the list. 

4.4.2.2 Clock 
The “Clock” field sets the rate of the output video clock, or how quickly each pixel 
datum is sent out.   

Westar Display Technologies, Inc. 
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4.4.2.3 Vertical 

 
Figure 16 Vertical Timing Diagram 

Total 
Vertical Total defines the total number of lines of output video, including blanking. 

Active 
Vertical Active defines the number of active or visible lines of output video. 

 Pulse Width 
Vertical Pulse Width defines the width of the vertical pulse in lines. 

Back Porch 
Vertical Back Porch defines the number of lines between the end of the vertical sync 
pulse and the beginning of active video. 

Front Porch 
Vertical Front Porch defines the number of lines between the end of active video and the 
beginning of the vertical sync pulse.  It is calculated automatically when a vertical timing 
parameter changes, and cannot be set. 

Polarity 
Vertical Polarity defines the polarity of the vertical sync pulse.  Select Positive if the 
pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.4.2.4 Horizontal 

 
Figure 17 Horizontal Timing Diagram 

Total 
Horizontal Total defines the total number of pixels in one line of output video, including 
blanking. 

Active 
Horizontal Active defines the number of active or visible pixels of one line of output 
video. 

 Pulse Width 
Horizontal Pulse Width defines the width of the horizontal sync pulse in pixels. 

Back Porch 
Horizontal Back Porch defines the number of pixels between the end of the horizontal 
sync pulse and the beginning of active video. 

Front Porch 
Horizontal Front Porch defines the number of lines between the end of active video and 
the beginning of the vertical sync pulse.  It is calculated automatically when a horizontal 
timing parameter changes, and cannot be set.   

Polarity 
Horizontal Polarity defines the polarity of the horizontal sync pulse.  Select Positive if 
the pulse is active high and Negative if the pulse is active low. 

Westar Display Technologies, Inc. 
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4.4.3 Output Electrical 
“Output Electrical” defines the format of the output video. 

4.4.3.1 Parallel 
Select Parallel if the output video format is parallel. 

4.4.3.2 LVDS 
Select LVDS if the output video format is LVDS (Low Voltage Different Signal). 

4.4.3.3 Data Mapping 
The output video data signals can be mapped in different fashions.  Select SPWG 8-bit 
(Normal) to use the SPWG configuration.  This configuration is also the mapping to use 
for normal parallel output.  Select LDI to use the LDI configuration.  Reserved is 
reserved for future mappings.  Select Green Mono to Grayscale to use the green input 
video signal to produce monochrome output. 

4.4.3.4 Dual Pixel 
Select Dual Pixel if the display being driven requires dual pixel video. 

4.4.3.5 Clock Edge 
Select Falling Edge to output pixel data on the falling edge of the output clock.  Select 
Rising Edge to output pixel data on the rising edge of the output clock. 

Westar Display Technologies, Inc. 
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4.5 Scale and Position 
The “Scale and Position” step configures the parameters that define the video I/O 
relationship.  It has support for selecting, scaling and positioning an area of interest (AOI) 
from the input video onto the output video. 

This is the third step in the configuration process.  To go directly to this step, click the 
button under “Step #3:  Scale and Position.” 

 
Figure 18 Scale and Position 

Westar Display Technologies, Inc. 
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4.5.1 Defining the Output Video 
There are three steps in defining the content of the output video.  First, select an area of 
interest (AOI) from the active area of the input video.  Second, scale and position the 
AOI into the active area of the output video.    Third, define the color to be used to fill 
any of the output active area that is not covered by the scaled and positioned AOI. 

4.5.1.1 Area of Interest 
The area of interest in the input video (AOI) is selected in the “Area of Interest” frame.  
The main window for selecting the AOI is proportional to the active area of the input 
video. 

The area of interest is selected by entering the offset and size, or selecting it within the 
“Area of Interest” window.  The AOI cannot go outside of the active area of the input 
video. 

 
Figure 19 Area of Interest 
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Entering the AOI Offset 
The offset of the AOI can be entered using the AOI Offset fields.  The vertical offset is 
the number of lines from the top of the input active area to begin the area of interest.  The 
horizontal offset is the number of pixels from the left of the input active area to begin the 
area of interest.  When these fields are changed, the position of the box in the “Area of 
Interest” window also changes. 

Entering the AOI Size 
The size of the area of interest can be entered using the AOI Size fields.  The vertical size 
is the number of lines in the AOI, and the horizontal size is the number of pixels in the 
area of interest.  When these fields are changed, the size of the box in the “Area of 
Interest” window also changes. 

Selecting the Area of Interest in the Window 
Within the “Area of Interest” window, the box can be moved and sized which coarsely 
selects the area of interest.  To move the box with the mouse, move the cursor inside the 

box, and the cursor will change into a “grabber” .  Click and hold the mouse button 

and the cursor will change into a “dragger” .  The box can then be dragged around 
within the window.  To change the size of the box, move the cursor to the border of the 
box, and the cursor will change into an arrow indicating the directions that the size can be 
changed in.  Click and drag to change the size.  When the box is moved, the “AOI” size 
and offset fields are updated. 

Full Screen 
To force the area of interest to be the entire input active area, select the option Full 
Screen.  When the area of interest is sized to be full screen, the option will be 
automatically selected. 

Preview Image 
A “preview image” can be used to represent an input source and show how the resulting 
output may appear.  To use an image select the button labeled Open… and an “Open 
Picture” window will appear.  A picture file with the extension “.bmp,” “.jpg,” or “.gif” 
may be used.  If a picture is not chosen, a default image is used.  When a change is made 
in the AOI or scale and position (see section 4.6.1.2), the image in the windows will be 
redrawn accordingly. 
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4.5.1.2 Scale and Position 
The scale and position of the area of interest (Scaled AOI) is set in the “Scale and 
Position” frame.  The window for setting the scaled AOI is proportional to the active area 
of the output. 

The scaled AOI is set by entering the offset and size, or setting it within the “Scale and 
Position” window.  The scaled AOI cannot go outside the output active area.  The 
minimum vertical size of the scaled AOI is one half of the area of interest size plus one 
line.  The minimum horizontal size of the scaled AOI is one half of the area of interest 
size plus one pixel. 

 
Figure 20 Scale and Position 

Entering the Scaled AOI Offset 
The offset of the scaled AOI can be entered using the Scaled AOI Offset fields.  The 
vertical offset is the number of lines from the top of the output active area.  The 
horizontal offset is the number of pixels from the left of the output active areas.  When 
these fields are changed, the position of the picture in the “Scale and Position” window 
also changes. 

Entering the Scaled AOI Size 
The size of the scaled AOI can be entered using the Scaled AOI Size fields.  The vertical 
size is the number of lines in the scaled AOI, and the horizontal size is the number of 
pixels in the scaled AOI.  When these fields are changed, the size of the picture in the 
“Scale and Position” window also changes. 
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Setting the Scaled AOI in the Window 
Within the “Scaled AOI” window, the picture can be moved and sized which coarsely 
sets the scaled AOI.  To move the picture with the mouse, move the cursor inside the 

picture, and the cursor will change into a “grabber” .  Click and hold the mouse 

button and the cursor will change into a “dragger” .  The picture can then be 
dragged around within the window.  To change the size of the picture, move the cursor to 
the border of the picture, and the cursor will change into an arrow indicating the 
directions that the size can be changed.  Click and drag to change the size.  When the 
picture is moved, the “Scaled AOI” size and offset fields are updated. 

Window Scaled AOI 
To force the scaled AOI size and offset to match the AOI, select the option Window.  If 
the scaled AOI is sized and positioned to match the AOI, the option will be selected 
automatically. 

Flip Scaled AOI 
The scaled AOI can be flipped vertically or horizontally as part of the output video.  To 
flip the scaled AOI vertically, select the Flip Vertical option.  To flip the scaled AOI 
horizontally, select the Flip Horizontal option. 

 
Figure 21 Normal Image 

 
Figure 22 Flipped Horizontally 

 
Figure 23 Flipped Vertically 

 
Figure 24 Flipped Vertically and Horizontally
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4.5.1.3 Fill Color 
A solid color is used to fill the rest of the output video.  The color is set using “Fill 
Color.”  Select the color using the sliders, or entering a value from 0 to 255 for each color 
component (RGB).  The color will be shown in the in “Scale and Position” window. 

 
Figure 25 Fill Color 
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4.6 Power Sequences 
Power sequences for the display and backlight being driven, and the action to take when 
loss of video is detected are setup in the “Power Sequences” step.  This is the fourth step 
in the configuration process.  To go directly to this step, click the button under “Step #4:  
Power Sequences.” 

 
Figure 26 Power Sequences 
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4.6.1 Setting Power Sequences 
The sequence of events to turn on and off the panel and backlight are set up under “Panel 
Power Sequences” and “Backlight Power Sequences.”  The sequences for the panel and 
backlight are set up separately, with a sequence to power up and power down. 

To edit a sequence, click Edit under the sequence type of sequence.  An editor window 
will then appear. 

 
Figure 27 Power Sequence Editor 

To add a new step to the sequence, click Add Step.  To define a step, first click the cell 
under “Action” for the step you are editing, and select an action from the list.  There are 
different options for “Action” depending on whether it is a panel or backlight power 
sequence.  Once the action is selected, select the “Parameter” by clicking the cell and 
selecting a parameter from the drop-down list.  If the action is “Delay,” enter the delay 
time in the cell. 

To move a step up in the order, select the step and click Move Step Up.  To move a step 
down, click Move Step Down.  To delete a step, select the step and click Delete Step.  
Once editing is completed, click OK.  To cancel editing and discard any changes, click 
Cancel. 

After exiting the edit window, the sequence will be shown in the box above the “Edit” 
button.  To clear the sequence, click Clear. 
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Panel Actions 
Action Description Parameter 

UUT Power Power to the panel being driven ON, OFF 
Video Video to the panel being drive ON, OFF 
Discrete 0 Discrete output voltage HIGH, GROUND 
Discrete 1 Discrete output voltage HIGH, GROUND 
Discrete 2 Discrete output voltage HIGH, GROUND 
Discrete 3 Discrete output voltage HIGH, GROUND 
Discrete 4 Discrete output voltage HIGH, GROUND 
Discrete 5 Discrete output voltage HIGH, GROUND 
Discrete 6 Discrete output voltage HIGH, GROUND 
Discrete 7 Discrete output voltage HIGH, GROUND 
Power Supply 0 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 1 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 2 Discrete output voltage to power supply HIGH, GROUND 
Power Supply 3 Discrete output voltage to power supply HIGH, GROUND 
Delay Delay for time Time (msec) 

4.6.1.1 Backlight Actions 
Action Description Parameter 

Backlight Power Power to the backlight being driven ON, OFF 
Backlight On/Off Discrete to turn on/off the backlight HIGH, GROUND 
Discrete 0 Discrete output voltage HIGH, GROUND 
Discrete 1 Discrete output voltage HIGH, GROUND 
Discrete 2 Discrete output voltage HIGH, GROUND 
Discrete 3 Discrete output voltage HIGH, GROUND 
Discrete 4 Discrete output voltage HIGH, GROUND 
Discrete 5 Discrete output voltage HIGH, GROUND 
Discrete 6 Discrete output voltage HIGH, GROUND 
Discrete 7 Discrete output voltage HIGH, GROUND 
Delay Delay for time Time (msec) 
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4.6.2 Video Lost Action 
When the loss of valid input video is detected, the power down sequence of the panel 
and/or backlight can be run, or the display can be driven to a flat color field.  

 
Figure 28 Video Lost Action 

4.6.2.1 Delay 
To delay an action after video is lost, enter the delay time in tenths of seconds into delay. 

4.6.2.2 Action 
Select the action to take by clicking on the corresponding button.  Select drive display to 
flat field to drive the display to a solid color indicated by “Field Color.”  Select power 
down the panel to run the panel power down sequence.  Select power down the 
backlight to run the backlight power down sequence.  Select power down the panel and 
backlight to run the panel and backlight power down sequences. 

4.6.2.3 Field Color 
If you selected “drive display to flat field,” select the color under “Field Color.”  Select 
the color using the sliders, or entering a value from 0 to 255 for each color component 
(RGB). 
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4.7 Contrast and Brightness Control 
The parameters for manually controlling the contrast and brightness of the display being 
driven are set up under “Contrast\Brightness Control.”   This is the fifth step in the 
configuration process.  To go directly to this step, click the button under “Step #5:  
Output Setup.”  

 
Figure 29 Contrast\Brightness Setup 

4.7.1 Contrast Setup 
The method of contrast control and the “Contrast Table” to use are selected under 
“Contrast Setup.”  (See section 7 for more about the Contrast Tables). 

4.7.1.1 Control Method 
Select the method of manually controlling the contrast under “Control Method.” 

Analog 
Select Analog to use the analog input to the VP7 as the control. 

If “Analog” is selected, the options under “Contrast Table” will change.  Select between -
9 to 9V (32 steps), 0 to 5V (16 steps), 0 to 9V (32 steps).  
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Digital 
Select Digital to use the digital contrast control. 

If “Digital” is selected, the options under “Contrast Table” will change.  Select between 
32 step and 16 steps.  

Remote 
Select Remote to use remote commands to control the contrast. 

None 
Select None if you do not wish to manually control the contrast.  The contrast will be set 
to the value made under “Color Adjustments” (section 4.8.1).  

4.7.1.2 Contrast Table Editor 
Click Contrast Table Editor to launch the “Contrast Table Editor” (see section 7.1). 

4.7.1.3 Power Up Value 
The “Power Up Value” is the step that the contrast is set to when the board is powered 
up.  This is only used if the digital control is used. 

Power Up Last Value 
Select Power Up last value to have the board remember the last contrast step when it 
was last powered down.   

Power Up Default Value 
Select Power Up default value to have the board power up with the same contrast step 
every time.  Enter the value into the box beside the option.  The range for the value is 1 to 
32 if Table 1 is used, and 1 to 16 if Table 2 is used. 

4.7.1.4 Increment Delay Time 
“Increment Delay Time” sets how quickly the contrast step is incremented when the 
digital control is held down.  The delay time is the time between each increment. 

Initial 
The “Initial” delay is the time between each increment during the first four steps, as the 
digital control is held down.  The time can range from 0 to 1912.5 microseconds. 

Final 
The “Initial” delay is the time between each increment after four steps, as the digital 
control is held down.  The time can range from 0 to 1912.5 microseconds. 
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4.7.2 Brightness Setup 
The method of brightness control and the brightness value to use at power up are selected 
under “Brightness Setup.” 

4.7.2.1 Control Method 
Select the method of manually controlling the brightness under “Control Method.” 

Digital 
Select Digital to use the digital brightness control. 

Remote 
Select Remote to use remote commands to control the brightness. 

None 
Select None if you do not wish to manually control the brightness. 

4.7.2.2 Power Up Value 
The “Power Up Value” is the value that the brightness is set to when the board is 
powered up.   

Power Up Last Value 
Select Power Up last value to have the board remember the last brightness value when it 
was last powered down.   

Power Up Default Value 
Select Power Up default value to have the board power up with the same brightness 
value every time.  Enter the value into the box beside the option.  The range for the value 
is 0 to 63. 

4.7.2.3 Increment Delay Time 
“Increment Delay Time” sets how quickly the brightness is incremented when the digital 
control is held down.  The delay time is the time between each increment. 

Initial 
The “Initial” delay is the time between each increment during the first four steps, as the 
digital control is held down.  The time can range from 0 to 1912.5 microseconds. 

Final 
The “Initial” delay is the time between each increment after four steps, as the digital 
control is held down.  The time can range from 0 to 1912.5 microseconds. 
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4.8 Input Capture Adjustments 
Adjustments are made to the input ADC sampling clock phase and capture boundaries 
during the “Input Capture Adjustments” step.  Also, adjustments to the color of the 
captured input video can be made.  This is the sixth and final step in the configuration 
process. To go directly to this step, click the button under “#6:  Input Capture 
Adjustments.” 

 
Figure 30 Input Capture Adjustments 
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4.8.1 Color Adjustments 
Adjustments to the color of the input source can be made under “Color Adjustments.”   
Three adjustments can be made:  Black Level, Contrast, and Brightness.  The 
adjustments are done for each color component, RGB, separately.  Enter the adjustments 
in the fields under “R,” “G,” and “B,” or click on the up and down arrows. 

 
Figure 31 Color Adjustments 

4.8.1.1 Black Level 
The Black Level value is subtracted from the color data from the input source.  The 
default value is “0.”  It can range from 0 to 255. 

4.8.1.2 Contrast 
Color data from the input source is multiplied by the Contrast value.  The default value 
is “1.”  It can range from 0 to 1.998. 

4.8.1.3 Brightness 
The Brightness value is added to the color data from the input source.  The default value 
is “0.”  It can range from 0 to 255. 

 

When used in conjunction, the color adjustments follow the following equations: 

R(out) = (R – RedBlackLevel) * RedContrast + RedBrightness 

G(out) = (G – GreenBlackLevel) * GreenContrast +GreenBrightness 

B(out) = (B – BlueBlackLevel) * BlueContrast + BlueBrightness 

The black level is applied first, followed by contrast, and then brightness. 
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4.8.2 Timing Adjustments 
To use the timing adjustments, a valid video source must be connected to the video input.  
It is recommended that the video output also be connected so the adjustments can be 
seen.  Before making timing adjustments, all the parameters must be applied.  If the 
parameters have not been applied, the adjustments will be disabled.  Also, if a VP7™ is 
not connected, the timing adjustments will be disabled. 

4.8.2.1 Sweep ADC Phase 
Click Sweep ADC Phase to run a test of different phase delays of the analog to digital 
converter sampling clock.  The process takes several minutes to complete.  When using 
the test, apply a pattern with high horizontal and vertical frequency content as the source, 
or a “busy” image. 

 
Figure 32 ADC Phase Plot 

The phase delay is varied over a range of 0 to 511.  For each delay, the sum of 
differences of consecutive pixel data is measured and plotted in the graph.  As the test 
progresses, the delay the yields the highest difference is tracked.  The best delay to 
choose corresponds to the peak of the widest sum of difference cycle. 

To stop the testing at any time, click STOP.   

After the test has been run, the delay that yields highest difference is applied.  The phase 
delay can also be selected manually by clicking on the graph or entering it into ADC 
Phase.  Click Set to program the delay if you wish to set it manually. 

4.8.2.2 Input Boundary Detect 
Clicking Input Boundary Detect adjusts the input capture area so the entire area is 
captured correctly.  When running the “Input Boundary Detect,” apply a pattern that 
defines the input active area as set up in Step #1:  Input Setup.  When it completes, if the 
pattern did not appear to define the input active area, a message will appear. 

To manually adjust the input boundary, click any of the arrow buttons surrounding the 
“Input Boundary Detect” button.  The input boundary will shift in the opposite direction 
of the arrow, causing the output image to shift in the direction of the arrow.  As the image 
is adjusted, the offsets are shown in “Horizontal Adjust” and “Vertical Adjust.”  To reset 
the adjustments to zero, click Reset. 
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4.9 Applying, Saving, and Restoring Parameters 
The Apply, Save, and Restore buttons appear at every step of the wizard at the bottom of 
the window, and in the VP7configure™ Wizard window.  To use any of the buttons, a 
VP7™ must be connected.  If one is not connected, an error message will appear if any of 
the buttons are clicked. 

 
Figure 33 Apply, Save, Restore 

4.9.1 Apply 
Clicking Apply sends all the parameters to the volatile memory of the VP7™, and 
applies them.  If there is a problem with one of the parameters, a message box will appear 
saying which set of parameters has a problem.  The parameters will not be applied if 
there is an error. 

After the “Apply” is done, the Apply button will be disabled and the Save button will be 
enabled.  Apply will be enabled again when there is a change to one of the parameters, 
and Save will be disabled. 

4.9.2 Save 
Clicking Save stores the parameters for the VP7™ channel.  The parameters that are in 
memory are copied into non-volatile memory, so the VP7™ channel can remember the 
parameters the next time it is powered down. 

When the Apply button is enabled, meaning there is unapplied changes to the parameters, 
the Save button is disabled.  The Save button is enabled after the current parameters are 
successfully applied to the VP7™ channel. 

4.9.3 Restore 
Clicking Restore reads back the parameters stored in nonvolatile memory of the VP7™ 
channel into volatile memory.  The parameters are then reapplied and read into the 
VP7configure™ program.  This can be used to discard recent changes and return to the 
last saved state. 
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5 Saving a Connection 
Files are saved as text files (*.txt) containing VP7™ text commands. 

To save a set of parameters to the PC, select File->Save from the menu, click the Save 
button in the VP7configure™ Wizard window, or press Ctrl + S on the keyboard.  If you 
haven’t saved the connection before, it will ask for a text file name.  You may enter a 
new name, or replace an existing file.  If you have saved already, it will not ask for a file 
name and save it under the same name. 

After a file is saved, the file name will be displayed in the title bar of the VP7configure™ 
Wizard window.  Before it is saved, it is given a default name. 

 
Figure 34 Unsaved File 

 
Figure 35 Saved File

To save an already saved connection under a different file name, select File->Save As… 
from the menu, or click the Save As… button in the VP7configure™ Wizard window.  
The program will then prompt for a text file name to save under. 
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6 Opening a Connection 
Text files containing VP7™ commands or files saved by VP7configure™ can be opened 
and loaded into the VP7configure™ Wizard. 

To open an existing file, select File->Open Connection from the menu or press Ctrl + O 
on the keyboard.  Choose the text file (*.txt) you wish to open. 

VP7configure™ checks each line in the file, and, if it is a valid VP7™ command, loads 
its parameters into the VP7configure™ Wizard.  If there is an invalid line in the file, an 
error message will be displayed showing the invalid line.  If an error message appears, 
click OK to continue reading the rest of the file, or click Cancel to stop. 

 
Figure 36 Invalid Line 

7 Feedback Level 
Two different levels of feedback can be used when communicating with a VP7.  To 
change the feedback level select Options->Set Feedback Level to High/Low. 

When “Low Feedback” is selected, if unexpected data is in the serial buffer while 
communicating with the VP7, it will be ignored, unless it is an error.  When “High 
Feedback” is selected, any unexpected data in the serial buffer will be shown in a 
message box, and the current VP7 communication will be stopped. 
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8 Contrast Tables 
The “Contrast Tables” are tables stored in the VP7™ which contain contrast values for 
each step of manual control.  There are three such tables for different analog voltage 
ranges and step numbers. 

If the contrast is being controlled by the analog input, one of the three tables can be used.  
Table 1 can be used for an input ranging from -9V to +9V, and has 32 steps.  Table 2 can 
be used for an input ranging from 0V to +5V, and has 16 steps.  Table 3 can be used for 
an input ranging from 0 to +9V, and has 32 steps. 

To select a value for the contrast under analog control, the input voltage is measured and 
compared to ranges for each step in the table.  For example, Table 1 is being used, which 
ranges from –9V to 9V.  The analog input is measured to be 0V.  Step 16 is chosen since 
0V falls within its range.  The contrast value stored in step 16 is used. 

If the contrast is being controlled by the digital contrast control, one of two tables can be 
used.  Table 1 can be used to have 32 contrast steps, and Table 2 can be used to have 16 
contrast steps.  The same contrast tables are used for digital control as the tables used for 
analog control, but the digital control disregards voltages ranges.  The step number to 
choose from the table is set by the digital counter. 
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8.1 Contrast Table Editor 
Use the “Contrast Table Editor” to change the contrast values stored in the contrast 
tables.  Select Maintenace->Contrast Table Editor to open the editor. 

 
Figure 37 Contrast Table Editor 

8.1.1 Editing a Table 
To edit a table, first select the tab for the table you wish to edit (Table 1, Table 2, or 
Table 3).  To change the contrast value for a certain step, move the slider beside the step 
number to the desired value.  As the slider moves, the “% Gain” is shown to the left. 

To return to the default table settings, click Restore Default Curves. 

To store the tables onto the VP7™, click Write to VP7 if a VP7™ is connected.  If one 
is not connected, this button is disabled. 

8.1.2 Saving a Table 
To save the settings for the tables to the PC, click Save.  Contrast table files are stored 
with the extension “*.cts.” 

8.1.3 Loading a Table 
To load a saved table settings file from PC, click Load.  You will then be prompted to 
select a file with the extension “*.cts.”  After selecting the file, its settings will be loaded 
into the editor. 
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